
Lesson 15 Advanced Cell P roperties

Les s on Topics
Absolute Cell References

Percentages

Exercise: Calculating Percentages

Exercise: Calculating Commissions

Les s on Objectives
At the end of the lesson, you will be able to:

Explain the difference between absolute and relative cell
references;

Use absolute cell references in workbooks;

Use the ABS key to enter absolute cell references;

Format values as percentages;

Use percentages in formulas for calculating sales tax.

Student Files Used
You will use the following files from your student folder:

Salaries 1

Salaries 2

Sales Tax

Contributions

Commission Report

Student Files Crea ted
You will save the following new file to your student folder:

New Commission Report
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Absolute
Cell
References

You have seen that when you copy a formula to other cells, the cell
references in the formula change. For example, if you were to copy
the formula =B3+C3 to the cell below, Excel would change the
formula to =B4+C4. This is because the cell references are relative.
Sometimes, however, you do not want a cell reference in a formula
to change when it is copied. You want it to be absolute.

It is easiest to learn this feature by writing a formula incorrectly
and noticing what happens when it is copied to other cells. You are 
going to use a workbook named Salaries.

1. Open Sal a ries 1.

This workbook contains a list of employee salaries.
At the top, notice that each employee is to receive a
bonus of $15 this week. Also notice that $2 is to be
deducted. You are going to use the techniques that
you have learned so far to write an incorrect formula 
in column C that will add the bonus to the salary.

2. Go to C6.

3. Type =B6+B1 and tap the ENTER key.

Notice that the result is correct: 365. You are going to 
copy this formula down to the other cells in the
column.

4. Go to C6.

5. On the Edit menu, choose Copy.

Tip: Re mem ber that you can use the Short cut menu,
toolbars or key board for many com mands.

6. Select C7:C13.
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7. Tap the ENTER key.

8. Click to remove the highlight.

Notice that the results are not correct. Some of the
values did not even change, and one has #VALUE!
in it. You are going to see why.

9. Use CTRL/~ (CTRL/TILDE) in order to display the
formulas. (Do not hold down the SHIFT key.)

The Formula Auditing toolbar appears. If it is in the
way, drag its title bar out of the way.

Notice the formulas in column C. When you copied
the contents of C6 into the other cells, Excel changed 
the cell references automatically. For example, the
formula in C7 reads =B7+B2. B7 is correct, but B2
contains the value for the deduction, not the bonus.
The cell reference for the bonus must always remain
B1,  otherwise, the formula will be incorrect. In other 
words, the cell reference for the bonus should be an
absolute cell reference, not a relative cell reference.
Notice the same problems in the other cells of
column C.

In C9, the incorrect formula =B9+B4 produces the
result #VALUE!. This is because B4 contains text, not 
a value.

10. Use CTRL/~ to hide the formulas.

To make a cell reference absolute, put a dollar sign ($) before each
part of it, like this: $B$1. This tells Excel not to change the column
letter or the row number when the formula is copied to other cells.

You are going make a correct formula using absolute cell
references.

1. Go to C6.

2. Type =B6+$B$1 and then tap the ENTER key.

Now when you copy the formula, B6 will change,
but B1 will remain the same. You are going to copy
the formula as before. The old formulas in those
cells will be overwritten with the new ones.

3. This time, you are going to use the Fill handle to copy
the formula.
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Go to C6.

4. Drag the Fill handle to C13.

Notice that the results are correct.

5. Use CTRL/~ to show the formulas.

Notice that the first cell reference changed
throughout column C, but $B$1 remained the same.

6. Use CTRL/~ to hide the formulas.

Note: You can also make only one part of the cell
ref er ence ab so lute. For ex am ple, $G11 makes the
col umn ab so lute, but the row num ber will change
when the for mula is cop ied. G$11 makes the row
ab so lute, but the col umn let ter will change when the 
for mula is cop ied. In your for mula it was not
nec es sary to put a dol lar sign in front of the col umn,
be cause it would not have changed when cop ied.
There fore, the for mula could have been writ ten
=B6+B$1.

The ABS key
(F4)

The ABS key (F4) saves you the trouble of typing the dollar signs in 
order to make an absolute cell reference. If you tap it once after
typing a cell reference, both dollar signs are inserted. Tapping it
twice puts a dollar sign before the row part only. Tapping it three
times puts a dollar sign before the column part only. Tapping it
four times removes the dollar signs.

You are going to re-type the formula for C6 in this manner.

1. Go to C6.
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2. Type the following, but do not tap the ENTER key:
=B6+B1

3. Tap the ABS key (F4).

Notice that the dollar signs were inserted in the
most recently typed cell reference (B1). The first cell
reference (B6) has not been changed.

4. Tap the ABS key (F4) again.

Only the row number has a dollar sign.

5. Tap the ABS key (F4) again.

Only the column letter has a dollar sign.

6. Tap the ABS key (F4) again.

The dollar sign disappears. The absolute cell
reference has been removed.

7. Tap the ABS key (F4) again.

Both dollar signs are again inserted.

8. Tap the ENTER key.

Re mem ber: You can use the ABS key (F4) to in sert
ab so lute cell ref er ences as you are typ ing a for mula. 

You are going to create the formulas for column D. This time B2
will be an absolute cell reference. This will then be subtracted from
the values in column C.

1. Go to D6.

2. Type: =C6-B2

3. Tap the ABS key (F4).

The dollar signs are inserted. The formula should
look like this: =C6-$B$2

4. Tap the ENTER key.

5. Copy this formula to D7:D13.

Your screen should look like the example at the top
of the next page.
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6. Go to D7.

Notice that the first cell reference changed to C7, but 
B2 remained the same.

7. Go to several other cells in column D and notice
the absolute cell references.

8. Change the values in B1 and B2 to other values
and watch the results change in the cells with
formulas.

9. Close Sal a ries 1. If you wish, save the changes (the
file will not be used again).

Percentages In arithmetic, a value with a percent sign is converted to a decimal
value by moving the decimal point two places to the left. For
example, 6% is the same as .06; 25% is the same as .25; 100% is the
same as 1, and 250% is the same as 2.5. If you have forgotten your
arithmetic, do not worry — Excel can convert percentages to
decimals automatically.

1. Open a new workbook.

2. You are going to enter a percentage and then reference 
it in a formula.

Verify that A1 is the current cell.

3. Type 25% and click the check box to keep the cell
ac tive.

Since you entered a value with a percent sign, 
Excel applied the Percentage format to the cell

196 Microsoft Excel 2003 - Beginning and Beyond



automatically. Notice that a percent sign appears 
in the cell and in the Formula bar.

4. On the Format menu, choose
Cells.

5. If necessary, click the Number
tab.

In the Category box, notice 
that Percentage is selected. 
Excel applied this 
format automatically.

6. Click OK to close the dialog box.

7. Go to B1.

8. Type 50 and then tap the TAB key to go to C1.

9. You are going to enter a formula to multiply the
percentage in A1 by the value in B1.

In C1, type =A1*B1 and then tap the ENTER key.

Notice the results of the formula (12.5). Excel
converted the percentage in A1 to a decimal in order 
to multiply the contents of the two cells.

10. You are going to change the value in A1.

Go to A1.

11. Type: 8

Notice that Excel maintains the percent symbol in
the cell and on the Formula bar. This is because
Excel has formatted the cell with the Percent format.

12. Tap the ENTER key.

Notice the results of the formula in C1. Excel has
evaluated 8% of 50.

You can hide the percent sign, by changing the number format of
the cell.

1. Go to A1.

2. Use CTRL/SHIFT/~ to apply the Gen eral for mat to
the cell.

Lesson 15 - Advanced Cell Properties 197



Notice that 0.08 now appears in the cell and on the
Formula bar. When you apply the General format,
Excel converted 8% to its decimal equivalent. Notice
that the value in C1 has not changed.

3. Close the workbook without saving.

Calculating a
Sales Tax

Now that you know how to display percentages, you are going to
use a workbook named Sales Tax.

1. Open Sales Tax.

Notice that the workbook is designed to calculate a
sales tax.

2. You are going to type 8% as the current sales tax rate.

Go to B4.

3. Type 8% and tap the ENTER key.

4. You are going to format the cell as a percentage with 2
decimal places.

Go to B4.

5. On the Format menu, choose Cells.

6. Verify that the Number tab is displayed.

7. Verify that Per cent age is cho sen in the Cat e gory list
box.

8. Change the contents of the Dec i mal places text box
to: 2

9. Click OK.

Notice that 8.00% is displayed in the cell.
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You can now find the Sales Tax Amount by multiplying the Purchase 
Amount by the Sales Tax Rate.

1. Go to B5.

2. Type =B3*B4 and tap the ENTER key.

The sales tax is 9.6.

3. Before continuing, you are going to change the format
of cells containing dollar amounts to the Currency
format with two decimal places.

Select cell B3, B5, B6, and B7. (Remember to hold
down the CTRL key after you select B3, so as not to 
de-select cells.)

4. On the Format menu, choose Cells.

5. Verify that the Number tab is displayed.

6. In the Cat e gory list box, choose Cur rency.

7. Verify that two decimal places have been chosen
and specify that negative numbers are displayed
within parentheses.

8. Click OK.

Notice that the Purchase Amount is now $120.00 and
the Sales Tax Amount is $9.60.

Note: You could also have changed to the Cur rency
for mat by click ing the Cur rency Style but ton on the
For mat ting toolbar, but we wanted to be sure you
were com fort able with the menu com mand.

There are two ways you can calculate the Total Amount.

1. Go to cell B6.

2. One way to calculate the total is to simply add the
purchase amount to the sales tax amount.

Type =B3+B5 and tap the ENTER key.

The total amount is $129.60.

3. You can also calculate the total by using only the
purchase amount and the sales tax rate. To do this,
simply multiply the purchase amount by the sum 
(1 + sales tax rate). In this case, you would multiply the 
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purchase amount by (1 + 0.08), which is the same as
1.08. (Be sure to convert the percent to a decimal.)

In B6, type =B3*(1+B4) and then tap the ENTER
key. (Re mem ber that Ex cel cal cu lates what ever is
in pa ren the ses first.)

Notice the results of the second formula. (Again, do
not worry if the arithmetic escapes you.) Although it 
may seem more complicated at first glance, the
second formula is a more direct way of calculating
the total amount.

A variation on this can be used to extract the sales tax from the
total amount to find out what the purchase amount was.

1. Go to B7.

2. Type =B6/(1+B4) and tap the ENTER key.

Your screen should look like the following:

You can see that the answer matches the Purchase
Amount in B3. This can also be used to show an 8%
decrease in a figure. Both of these variations are
useful for developing projected figures quickly.

3. Close the workbook. It will not be used again.
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Exercise:
Calculating
Percentages

In the following example, four people have made charitable
contributions. You are interested in knowing what percentage of
the total was contributed by each person.

1. Open Con tri bu tions.

2. The first task is to use a SUM function in order to find
out the total contributions.

Go to B8.

3. On the Standard toolbar, click the AutoSum button.

The formula =SUM(B3:B7) is entered on the Formula 
bar.

4. Tap the ENTER key.

87,000 is entered in B8.

5. The percentage of the total can be found by dividing
the individual contribution by the total contribution. The 
reference to B8 should be absolute, so that the total
does not change as you copy the formula down.

Go to C3.

6. Type =B3/$B$8 and tap the ENTER key.

Notice that a value with a lot of decimal places
appears.

7. You are going to format this cell as a percentage with
two decimal places. When you copy the cell down, the
formatting information will be copied with it.

Go to C3.

8. Instead of using the Format Cells dialog box, you are
going to use the buttons on the Formatting toolbar.

On the Formatting toolbar, click the Percent
Style button.

Lesson 15 - Advanced Cell Properties 201



Notice that the number is formatted with a percent
sign.

9. You are going to add two places after the decimal
point.

On the Formatting toolbar, click the Increase
Decimal button two times.

The value changes to 24.14%.

10. Copy the formula to C4:C6.

11. Click to remove the highlight.

You can now see what percentage of the total each
person contributed. Your screen should look like the 
example on the next page. (The bottom border in C6
was removed, because the format of C3 was also
copied. It is not necessary to replace it.)

12. Go to other cells with formulas and notice that B8
remained an absolute cell reference.

13. Close the workbook. It will not be used again.

Exercise:
Calculating
Commissions

In this exercise you will calculate each sales person’s commission
and its percent of the total commissions. If you need step-by-step
instructions, refer to the Solutions section following the exercise.
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1. If you feel you need the practice, feel free to type
the above workbook yourself. If not, open
Com mis sion Re port, which has the in for ma tion
en tered al ready.

2. Go to B3 and type 12% for the com mis sion rate.

3. Format this cell with the Per cent age for mat with 2
dec i mal places.

4. You are going to change the format of B7:C12.

Select B7:C12.

5. On the Format menu, choose Cells.

6. On the Number tab, choose a number format with
no decimal places and a thousands separator. It
does not matter if negative numbers are displayed, 
so you can ignore that option.

7. Click OK.

8. Go to C7 and write a formula that will calculate
Locke’s commission. Remember that the current
commission rate is in cell B3.

9. Copy this formula down to C8:C11. The bottom
border in C11 will be removed because you are
also copying the format of C8, which does not have 
a bottom border. You will fix it shortly.

10. Go to C12 and write a SUM function that adds the
commissions.

11. Go to D7 and write a formula that divides the
commission in C7 by the total commissions in C12.

12. Format the cell with the Percentage format with 2
decimal places.

13. Copy the formula to D8:D11.

14. Format A11:D11 with a medium line at the bottom
of the cells.
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Your screen should look like the following:

15. Type other values into B3 and notice how the
commissions change.

16. Save the workbook as New Com mis sion Re port.

End of Lesson 15
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